
 

توسعه و ترویج خدمت به نقش خیرین سلامت در 

بهداشت و پیشگیری و درمان در شهرستان طرقبه 

 و شاندیز
 مجمع سلامت شهرستان طرقبه و شاندیز

Heading 1 

On the Insert tab, the galleries include items that are designed to coordinate with the overall 

look of your document. You can use these galleries to insert tables, headers, footers, lists, cover 

pages, and other document building blocks. When you create pictures, charts, or diagrams, they 

also coordinate with your current document look. 

Heading 2 
You can easily change the formatting of selected text in the document text by choosing a look for 

the selected text from the Quick Styles gallery on the Home tab. You can also format text directly 

by using the other controls on the Home tab. Most controls offer a choice of using the look from 

the current theme or using a format that you specify directly.  

To change the overall look of your document, choose new Theme elements on the Page Layout 

tab. To change the looks available in the Quick Style gallery, use the Change Current Quick Style 

Set command. Both the Themes gallery and the Quick Styles gallery provide reset commands so 

that you can always restore the look of your document to the original contained in your current 

template. 

Heading 3 
On the Insert tab, the galleries include items that are designed to coordinate with the overall 

look of your document. You can use these galleries to insert tables, headers, footers, lists, cover 

pages, and other document building blocks. When you create pictures, charts, or diagrams, they 

also coordinate with your current document look. 

 

 

 

 

 

 قدمه: اهمیت بهداشت و پیشگیری در سلامت جامعهم

 

 

خدمت به بهداشت و  جیسلامت در توسعه و ترو نیرینقش خ

 زیو درمان در شهرستان طرقبه و شاند یریشگیپ
 مجمع سلامت شهرستان طرقبه و شاندیز

 4141اردیبهشت ماه 

 

 

 

روابط عمومیواحد تهیه و تنظیم :   
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 ت جامعهلاممقدمه: اهمیت بهداشت و پیشگیری در س

لامت، نظام سها بلکه نتیجه پیشگیری و اتخاذ سبک زندگی سالم است. سلامت جامعه، نه تنها حاصل درمان بیماری

وار های اولیه بهداشت استدر کنار ارائه خدمات درمانی، بر اساس آموزش، پیشگیری، واکسیناسیون و توسعه زیرساخت

های بهداشت، نقش کلیدی های سلامت و خانهاست. این رویکرد، از طریق توسعه مراکز خدمات جامع سلامت، پایگاه

 .جامعه داردها و افزایش کیفیت زندگی در کاهش بیماری

های بزرگ، تمرکز بر توسعه این مراکز پایه، اهمیت بیشتری در شهرستان طرقبه و شاندیز، به دلیل نبود بیمارستان

وطنان یافته است؛ زیرا این مرکزها، قلب نظام سلامت اولیه، آموزش بهداشت و پیشگیری هستند که آینده سلامت هم

 .کنندما را تضمین می

 ایت خیّرین در حوزه بهداشت و پیشگیریضرورت و اهمیت حم

های اولیه سلامت و پیشگیری دارند. در بسیاری بدیلی در توسعه زیرساختهای مادی و معنوی خیّرین، نقش بیحمایت

ها، ارتقاء سطح های کشور، همکاری مردمی و خیّرین، نتایج قابل توجهی در کاهش بیماریها و شهرستاناز استان

 .های سلامت عمومی داشته استبهداشتی و توسعه شاخصهای آموزش

های پیشگیرانه، مستقیماً بر کاهش در حوزه بهداشت، هر کمک، چه در ساخت و تجهیز مراکز، چه در اجرای برنامه

گذارد. خیّرین با نیت خیر، در کنار نظام سلامت، های درمان آینده و بهبود مستقیم کیفیت زندگی تأثیر میهزینه

 .زنندتر را رقم میای سالمدهند و آیندهه پیشگیری و سلامت را شکل میچرخ

 نطقه ایم فعالیت هاینقش نظام سلامت در بخش بهداشت و 

های پیشگیری، آموزش عمومی و ساخت مراکز اولیه خدمات بهداشتی نظام سلامت، مسئولیت توسعه و استقرار برنامه

های های بهداشت، پایگاه، این نقش عمدتاً در قالب توسعه و تجهیز خانهشاندیز ن طرقبه و را بر عهده دارد. در شهرستا

 .، غذا و دارو تعریف می گردد 111پیش بیمارستانی اورژانس خدمات  ،های غربالگری سلامت و برنامه

 :کارکردهای کلیدی شامل موارد زیر است

 های بهداشتساخت و توسعه مراکز خدمات جامع سلامت و خانه 

 های آموزش همگانی، ترویج تغذیه سالم و بهداشت فردیبرگزاری برنامه 

 هاای و کنترل بیماریهای دورهاجرای واکسیناسیون، غربالگری 

  111فوریت های پزشکی و خدمات پیش بیمارستانی اورژانس 

 دماتقاء کیفیت خکنندگان برای تامین و ارتگیری از منابع مالی و تجهیزات حمایتهمکاری با خیّرین و بهره 

 .ها و ارتقاء سلامت جامعه استهای مزمن، کنترل اپیدمیاین اقدامات، عامل کاهش بار بیماری

  
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 و درمان طرقبه و شاندیز های همکاری و نقش خیّرین در توسعه شبکه بهداشتفرصت

امت های اولیه سلزیرساخت، مشارکت فعال خیّرین در توسعه طرقبه و شاندیز  ها و افتخارات شهرستانیکی از فرصت

 .است

 :شودهای حمایت شامل موارد زیر میترین زمینهمهم

 محروم مناطق و روستاها در های سلامتهای بهداشت و پایگاهساخت و تجهیز خانه 

  111خرید آمبولانس و موتورلانس جهت اورژانس 

 تامین هزینه های تعمیر و نگهداری آمبولانس های شبکه 

  بهداشتی لوازم و آموزشی مواد ها،دستگاه خرید در تجهیزاتیحمایت مالی و 

 با محوریت سلامت خانواده ،  محور،های سلامتبرپایی کارگاه  :های فرهنگی و آموزشیهمکاری در برنامه

 ترویج سبک زندگی سالم  ، جمعیت و فرزندآوری

 های غربالگری و واکسیناسیونحمایت در اجرای برنامه 

 ها و ایجاد سیستم پایدار، نقش موثری ها، ارتقاء سطح سلامت خانوادهدر کاهش بار بیماری ها،این مشارکت

 .دارند

 گذاری کنیم؟چرا باید در توسعه نظام سلامت منطقه سرمایه

های هزینه و موثر برای تضمین سلامت آینده است. ساخت و توسعه مراکز بهداشت و خانهپیشگیری، راهکار کم

ن، های مزمکند و نقش کلیدی در کاهش بیماریتر را برای مردم فراهم میتر و آساندسترسی سریعبهداشت محلی، 

 .ها و ارتقاء سلامت عمومی داردکنترل اپیدمی

های درمانی و ارتقاء جویی در هزینهدر نتیجه، حمایت و مشارکت خیّرین، نه تنها امروز بلکه در آینده، باعث صرفه

 .شودیکیفیت زندگی افراد م

 در سال های گذشته  مشارکت خیرین سلامت در شهرستان طرقبه و شاندیزهای نمونه

های زیادی از نقش خیّرین در توسعه مراکز بهداشت و پیشگیری ، نمونهشهرستان طرقبه و شاندیزدر 

 :های بارز آن عبارتند ازوجود دارد که نمونه

 441و اورژنس  برای ساخت پروژه های بهداشتی و هزینه احداث  تامین زمین  -

 زشک  441پایگاه اورژانس 

  0011سال شروع: 

 0012 بهمن تاریخ افتتاح:  



 

 

 

 

 

 

یز
ند

شا
 و 

به
رق

 ط
ان

ست
هر

 ش
در

ن 
رما

 د
ی و

یر
شگ

 پی
ت و

اش
هد

ه ب
ت ب

دم
 خ

یج
رو

و ت
ه 

سع
تو

در 
ت 

لام
 س

ن
ری

خی
ش 

 نق

 

3 

 مربع 011به متراژ واگذاری زمین از سوی شورای اسلامی و دهیاری روستای زشک 

 ریال 11/111/111/37کل کمک خیرین :       متر مربع  202زیر بنا 

 گلستان   441پایگاه اورژانس 

  0731سال شروع: 

 0010تاریخ افتتاح:  بهمن ماه 

  022متراژ زمین :

 ریال 111/111/111/00کمک به ساخت ساختمان پایگاه به میزان : 

 پایگاه اورژانس نقندر :

 0732سال شروع: 

 0731هفته دولت تاریخ افتتاح:  

 متر مربع 051واگذاری زمین از سوی شورای اسلامی و دهیاری روستای نقندر به متراژ 

 ریال 111/111/111/0کمک به ساخت ساختمان پایگاه اورژانس نقندر به میزان : 

 (2خانه بهداشت چاهشک )

 0733سال شروع: 

 0017تاریخ افتتاح:  بهمن ماه 

 711به متراژ   شورای اسلامی چاهشکواگذاری زمین از سوی 

 (2) پایگاه سلامت مسکن مهر شاندیز

 0017سال شروع: 

 0017 هفته دولتتاریخ افتتاح:  

  31به متراژ   شهرداری محترم شاندیزاز سوی  ساختمان تعمیر و تجهیز

 ریال 111/111/111/1ساختمان به میزان :  تجهیزکمک به 

 441تعمیرات آمبولانس های اورژانس 

و ارتقاء خدمات پزشکی از راه دور * )تله مدیسین( واحد اورژانس  005کمک به تعمیرات آمبولانس های اورژانس 

 شبکه  005
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 نیازسنجی حوزه های مشارکت خیرین : 

 شبکه بهداشت و درمان طرقبه و شاندیز ستاد پروژه ساخت

 از طرف مرحوم علی سربرقی مقدم پدر معظم شهید محمد باقرسربرقی مقدم  0731تحویل زمین در سال 

  02متر مربع در ویلاشهر ، خیابان امام رضا )ع(  0111به متراژ : 

 تا مرحله اجرای فندانسیون 0730شروع عملیات ساخت : 

 ز به کار نمودآغا %01تا مرحله  اجرای ستون ها با پیشرفت  0732تعطیل و مجددا در سال  0732تا سال 

به  0017مراحل اجرایی آغاز و تا سال  0010سپس به دلیل کمبود اعتبارات تعطیل و مجدد در سال 

 میلیارد ریال  111/111/111/251میزان اعتبار مورد نیاز :  رسید. %05پیشرفت فیزیکی کلی 

  441دستگاه آمبولانس اورژانس  6تامین 

دستگاه به دلیل هزینه های بالای تعمیر و  0دستگاه می باشد که  00تعداد کل آمبولانس های موجود 

  میلیارد ریال 111/111/111/02نگهداری از فعالیت خارج شده اند که برای این منظور نیازمند 

 

دستگاه آمبولانس دیگر  2همچنین برای خدمت رسانی بهتر به شهروندان محترم طرقبه و شاندیز نیاز به 

 می باشد. ریال 501.111.111.111مبلغ به 

  441دستگاه موتورلانس برای  اورژانس  4تامین 

تسریع در حضور بر بالین بیمار و همچنین ترافیک بالای محور  کارائی بالای موتولانس برای  دلیل به

طرقبه و شاندیز ضرورت تامین یک دستگاه موتورلانس دیگر برای خدمت رسانی به بیماران احساس می 

 دد.گر

 میلیارد ریال  5.111.111.111میزان اعتبار مورد نیاز : 
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 :ساختمان مراکز نیازمند احداث( : 4شماره )جدول 

 اعتبار مورد نیاز کل متراز نام مرکز  ردیف

 71.111.111.111 زیربنا021 شاندیز 005ساختمان پایگاه اورژانس  0

 71.111.111.111 زیربنا 021 مغان 005ساختمان پایگاه اورژانس  2

 

 مراکز در حال احداث نیازمند تامین اعتبار :( : 2شماره )

 اعتبار مورد نیاز کل وضعیت ساختمان مرکز نام  ردیف

 251.111.111.111 در حال احداث ستاد شبکه بهداشت و درمان شهرستان طرقبه و شاندیز 0

 07.111.111.111 در حال احداث (2ساختمان خانه بهداشت ابرده ) 2

 

 :تجدید بنا مراکز نیازمند  ( : 3شماره )

 اعتبار مورد نیاز کل قدمت ساختمان  مرکز نام  ردیف

 221.111.111.111 سال 51بیش از  مرکز خدمات جامع سلامت طرقبه 0

 221.111.111.111 سال 51بیش از  مرکز خدمات جامع سلامت شاندیز 2

 

 وسائل نقلیه مورد نیاز: ( : 1شماره )

 اعتبار مورد نیاز کل اعتبار مورد نیازیک عدد)تومان( تعداد مورد نیاز وسیله نام  ردیف

 501.111.111.111 3.111.111.111 دستگاه 2 آمبولانس  0

 5.111.111.111 5.111.111.111 دستگاه 0 موتورلانس 2

 

 : 441آمبولانس  راتیتعم نهی( :  هز5شماره )

 شرح هزینه (ریال)هزینه تعمیر کد آمبولانس وسیله نام  ردیف

 تعمیر موتور 5.111.111.111 7117 آمبولانس  پایگاه نقندر 0

 موتور ریتعم 2.111.111.111  7305کد یدک شاندیزآمبولانس  پایگاه  2

 موتور ریتعم 2.111.111.111 7377کد اصلی ویرانیآمبولانس  پایگاه  7

 موتور ریتعم 0.111.111.111 7327 شریعتیآمبولانس  پایگاه  0

 موتور ریتعم 7.111.111.111 7325 شریعتیآمبولانس  پایگاه  5

 موتور ریتعم 02.111.111.111 5 جمع کل 
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 تجهیزات مورد نیاز: ( : 6شماره )

 مورد نیاز کلاعتبار  اعتبار مورد نیازیک عدد)تومان( تعداد مورد نیاز نام تجهیز ردیف

 2205110111 205110111 25 فشارسنج  بزرگسال 0

 7501110111 205110111 00 فشارسنج اطفال 2

 0001110111 705110111 0 ترازوی پرتابل 7

 7501110111 301110111 5 ترازوی بزرگسال با قدسنج / ترازوی باسکولی 0

 0201110111 701110111 0 ترازوی اطفال 5

 0201110111 001110111 0 اطفال میز قدسنج 2

 0205110111 005110111 7 ترمومتر لیزری 1

 0 5101110111 5101110111 (ECGالکتروکاردیوگراف ) 3

 0501110111 0501110111 0 ساکشن 01

 00101110111 7501110111 0 اتوکلاو سطلی 00

 22501110111 2501110111 3 سونی کید 02

 05001110111 2201110111 2 )با درج تعداد تیغه( لارنگوسکوپ بزرگسال 07

 2701110111 301110111 0 لارنگوسکوپ اطفال )با درج تعداد تیغه( 00

 01501110111 0501110111 3 اتوسکوپ-ست افتالموسکوپ 05

 0101110111 501110111 1 اتوسکوپ 03

 UV 2 501110111 0101110111دستگاه اشعه  01

 وزنه شاهد 21

 201110111 201110111 2110111 گرمی 211

 3110111 3110111 7110111 گرمی 511

 0501110111 0501110111 5110111 کیلوگرمی 2

 2702110111 2702110111 1110111 کیلوگرمی 5

 005110111 005110111 0 نگاتوسکوپ 20

 2001110111 101110111 7 مانیتورینگ علائم حیاتی 22

 0021101110111 01101110111 7 الکتروشوک 27

 0101110111 205110111 0 )مرکز شبانه روزی( CPRتخت احیا/ 20

 2001110111 301110111 7 تخت بستری 25

21 
دستگاه آلارم)سیستم ثبت الکترونیک دما با 

 قابلیت پایش از راه دور(
01 0101110111 01101110111 

 B 0 25101110111 25101110111اتوکلاو کلاس  23

 31101110111 75101110111 2 یونیت دندانپزشکی 71

 2021101110111 2101110111 71 سیستم کامپیوتر 70

 00501110111 501110111 27 میز اداری 72

 02101110111 001110111 71 صندلی گردان 77

 00101110111 7501110111 0 دستگاه حضور و غیاب 70

 5301110111 005110111 71 تلفن 75

 05101110111 0101110111 05 دیتا لاگر)سیستم ثبت دما( 72

 05101110111 0501110111 01 یخچال  73

 



 

 

 

 

 

 

یز
ند

شا
 و 

به
رق

 ط
ان

ست
هر

 ش
در

ن 
رما

 د
ی و

یر
شگ

 پی
ت و

اش
هد

ه ب
ت ب

دم
 خ

یج
رو

و ت
ه 

سع
تو

در 
ت 

لام
 س

ن
ری

خی
ش 

 نق

 

7 

 )به تومان( اعتبار مورد نیاز کل اعتبار مورد نیازیک عدد)تومان( تعداد مورد نیاز نام تجهیز ردیف

 7101110111 0501110111 2 آبگرمکن  71

 2501110111 001110111 25 گلوکومتر 73

 01101110111 201110111 51 دماسنج عقربه ای  01

 05101110111 701110111 51 دماسنج ماکزیمم ، مینیمم 00

 301110111 005110111 2 کلد باکس 02

 00101110111 301110111 21 واکسن کریر 07

 2001110111 310111 711 آیس بگ 00

 3101110111 3101110111 0 یونیت دوم زنجیره سرماتابلو برق  05

 05101110111 5101110111 7 اسپیلت 02

 20101110111 1101110111 7 موتور برق 03

 21101110111 2101110111 01 سیستم رایانه 01

 01101110111 2101110111 7 دوربین مدابسته  03

 01101110111 7101110111 2 دستگاه تله مدیسین )دستگاه نوار قلب آنلاین( 51

 1051002110111   جمع کل  
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